
   

 

 

Converting Your PDFs to Excel 
STEP 1: OPEN YOUR PDF 

Click on the Open icon on the main toolbar. Open the PDF you 
want to convert to Excel. 

 

STEP 2: SELECT PDF DATA TO CONVERT 

By default, the entire document is selected for conversion. 
Additional selection options are available: 

1. Mouse Based Selection  

a. Left click the mouse button beginning at the position 
from which you want to select data.  

b. Drag the mouse pointer (while still holding the left 
button pressed) over the content you want to select. 

2. Side Panel Selection Options 

a. Select Page: Select all data on the current page you’re 
viewing.  

b. Select Range…: Use this to select certain pages of the 
document, e.g. Pages 1, 4, 9-12, 17. 

c. Select All: Selects all pages of the PDF document. 

d. Revert Last Change: Use this option to cancel the last 
selection.  

 

STEP 3: CONVERT PDF TO EXCEL 

To convert your PDF to Excel, click on the Excel icon on the main 
toolbar.  

 

STEP 3a: PDF TO EXCEL CONVERSION OPTIONS 

1. Automatic (Default) 

Automatic option is recommended for most conversions into 
Excel. Able2Extract Professional will automatically determine the 
positioning of the Excel columns.  

Click the Convert button to convert your PDF file.  

2. Custom (Advanced) 

Custom option is used for complex PDF table conversions where 
users can manually designate row and column structure prior to 
conversion.  

To use the Custom Excel options, click on the Define button, then 
define your structure options in the dialog window.  Click on OK. 

 

STEP 3b: USING THE CUSTOM EXCEL CONVERSION TOOLS 

In the Custom Excel tab, use the available tools from the main 
toolbar as well as side panel options to manually designate the 
column and row structure for the conversion into Excel, and more. 

Main Custom Excel Tools 

 

1. Templates 

a. Load Template: Load and apply a previously saved 
Custom PDF to Excel table structure template. 

b. Save Template: Overwrite the template you loaded and 
updated. 

c. Save Template As: Save an active document’s defined 
table structure as a Custom PDF to Excel template for 
reuse on similarly formatted documents. 

2. Tables 

a. Add Table: Add a table to selection. 

b. Delete Table: Remove a table from selection. Once activated, 
left click on the table you wish to delete. 

3. Columns 

c. Add Column: Add a column. Once activated, left click to add 
a vertical column line. 

d. Delete Column: Erase a column line. Left click on a column to 
erase it. 

4. Rows 

To activate the feature, you must check Show Rows and Manual 
Row Editing options in the right-side panel first. 

a. Add Row: Left click to add a row. 

b. Delete Row: Left click to erase a row. 

5. Convert To  

Use 3 conversion options from the main toolbar to export your 
table selection to Excel and CSV or Copy to clipboard for easy 
pasting into the app of your choice. 

Custom Excel Side Panel Options 

1. Page Range 

You can first designate a page range for applying and customizing 
the file’s table structure. 

a. Current Page Range: A table structure has been applied 
to each page of the indicated page range. 

b. Extend...: Extend a table structure over more pages. 

c. Exclude: Exclude a page within a previously selected Page 
Range. 



   

 

 

 

2. Tables 

a. Replot: Automatically recalculates the column structure 
for all tables within the active page range. 

b. Find similar: Finds similarly structured tables within the 
document. 

 

3. Columns 

Once a table is created, you can edit the column structure using: 

a. Splitting Settings...: Decide how cell content is treated 
(such as text or numbers) when it comes into contact or 
into close contact with a column line. 

b. Column Types: Decide how the content within each 
column is treated for the purposes of Excel – like 
numbers, by default, or text. 

 

4. Rows 

a. Show Rows: Show the rows on the page. 

b. Manual Row Editing: When this option is checked, the 
“Add Row” and “Delete Row” functionalities are 
activated. 

c. Row Settings...: Demarcate the rows based on a specific 
column table within a table or by using the existing row 
lines on the page. 

 

5. Header and Footer 

a. Settings...: Use to enable/disable the headers and 
footers. Content of the PDF that is covered by header 
and/or footer will not appear in the converted document. 

b. Edit Header: When activated, lets you adjust the header. 
To adjust the header, use your mouse and left click the 
header, hold, and move the mouse up and down. 

c. Edit Footer: Allows you to adjust the footer. Left click the 
footer line and adjust accordingly. 

 

6. View 

Check the Show Preview checkbox to get the Excel spreadsheet 
preview of your PDF selection below the working area. If you want 
to preview the whole document, uncheck the Only Current Page 
checkbox. Show Selection checkbox lets you hide the blue 
highlight that’s visible across the selected page range when this 
option is active. 

 

To convert your file, click on the Convert To Excel button and save 
your file to complete your conversion. 

Additional conversion settings, including OCR languages, can be 
found under the Conversion Options button in the Convert tab. 

Converting Your PDFs to Word 
STEP 1: OPEN YOUR PDF 

Click on the Open icon on the main toolbar.  Open the PDF you 
want to convert to Word.  

 

STEP 2:  SELECT PDF DATA TO CONVERT 

By default, the entire document is selected for conversion. 
Additional selection options are available: 

1. Mouse Based Selection 

a. Left click the mouse button beginning at the position 
from which you want to select text. 

b. Drag the mouse pointer (while still holding the left 
button pressed) over the text you want to select. 

2. Select Menu Options 



   

 

 

a. Select Page: Select all data on the current page you’re 
viewing.  

b. Select Range…: Use this to select certain pages of the 
document, e.g. Pages 1, 4, 9-12, 17. 

c. Select All: Selects all pages of the PDF document. 

d. Revert Last Change: Use this option to cancel the last 
selection.  

 

STEP 3: CONVERT PDF TO WORD 

To convert your PDF to Word, click on the Word icon on the main 
toolbar.  

 

Additional conversion settings, including OCR languages, can be 
found under the Conversion Options button in the Convert tab. 

Editing Your PDF 
To Edit PDF content, click on the Edit Document tab on the main 
toolbar.  

There, you can modify your PDF using the tools from the main 
toolbar and customize it using options from the Properties panel 
on the right.  

Once you are satisfied with changes made to your document you 
can Save the changes from File tab on the main toolbar. 

PDF Content Editing Tools 

 

Use the content editing tools from the main toolbar to:  

a. Add Text: Add text to your page. 

b. Add Shapes: Add vector shapes to your page. 

c. Add Bitmap: Add bitmap images (JPG, BMP, PNG, TIFF, 
GIF) to your page. 

d. Redact: Permanently redact any sensitive information. 

e. Delete: Delete PDF content from the PDF page. 

PDF Page Editing Tools 

 

Use the page editing tools from the main toolbar to:  

a. Add Bates Numbering: Index your PDF pages with Bates 
numbering.  

b. Remove Bates Numbering: Remove previously applied 
Bates Numbering.  

c. Merge: Insert pages from other PDFs into your opened 
PDF document.  

d. Split: Extract pages from the currently opened PDF into a 
new and separate PDF file. 

e. Insert Pages: Inserts blank pages into your PDF. You can 
add PDF content directly to the pages that you insert. 

f. Delete Pages: Remove pages from your PDF. 

g. Move Pages: Move pages from one location in the PDF to 
another. 

h. Rotate: Rotate PDF pages 90 degrees clockwise or 
counterclockwise. 

i. Resize: Resize your PDF page to specific sizes. The 
content on the page itself remains intact.  

Properties Panel Options 

In the right-side panel, designate properties for PDF text and 
graphic elements such as: font, font size, fill with color, outline 
with color, line width, border style, dash pattern, line spacing, text 
block alignment, and more.  

 

Signing PDF Documents  
You can add an electronic signature or a digital (cryptographic) 
signature to your PDF document. 

1. Open your PDF using the Open icon on the main toolbar. 

2. Click on the Sign and Secure tab to reveal signature tools. 

3. Click on Choose Signature.  

4. Choose one or both of the available options:  



   

 

 

 

i) Check the Add Signature Image option to create an electronic 
signature.  

 a. Click on Create… 

 b. In the Add Signature Image dialog, Type, Draw or 
 Import your signature. 

 c. Click on Add and then on the Sign button in the 
 Signatures dialog. 

ii) Check the Digitally Sign the Document option to add a 
cryptographic signature.  

 a. Select the digital certificate from the list. 

5. Click on Sign and place the signature where you want it on the 
page. 

 

 6. Save the signed PDF by clicking on the Save button. 

Annotating PDF Content 
To start annotating your PDF content, switch to the Review tab on 
the main toolbar, and use any of the available annotation tools: 

 

Filling in PDF Forms 
Fill in interactive PDF forms that you created or modified with 
Able2Extract Professional’s PDF form creator and editor.  

1. Open your PDF form in Able2Extract Professional.  

2. Click on the File tab on the main toolbar.   

3. Fill in and save the PDF form to your computer or 
submit your data directly to servers.  

Creating and Editing PDF Forms 
To start creating and editing interactive PDF forms, click on the 
Edit Form tab on the toolbar.  

Use the PDF form editing tools on the main toolbar to: 

1. Add Text Box: Inserts a text field into the form. 

2. Add Combo box: Adds a combo box and adds new items 
or deletes the existing ones. 

3. Add Checkbox: Inserts a checkbox into the form. 

4. Add List box: Adds a list box to the form. 

5. Add Radio button: Inserts the radio button to the 
existing group or creates a new radio button group.  

6. Add Action button: Resets and clears form filling fields 
or submits a new custom action. 

7. Add Signature: Adds a signature placeholder form field 
to the PDF form. 

Properties Panel Options 

In the right-side panel, designate properties for form fields such 
as: name, font, font size, text color, border and background color, 
line width, border style and dash pattern.  

Define read-only and required fields. Click the More button to 
specify additional form properties for the selected form field.  

Compare Printable Documents 
To use Able2Extract Pro for comparing any two printable 
documents, click on the Compare tab on the toolbar. 

Click on the first Open for Compare button and select documents: 

a. Browse for the first document and click the Open 
button. After another browsing window appears, repeat 
the process. 

b. If both files are in the same folder, click on the first one 
and, before confirming selection via the Open button, 
CTRL + select the second document for comparison. 

In the Compare Documents dialog box select what elements 
Able2Extract should compare: 

1. Compare Text 
2. Compare Shapes (vectors) 
3. Compare Bitmaps (images) 

The comparison tool will highlight content that is similar in both 
documents and unique for one of them, allowing users to quickly 
identify any variations between the documents. 

Users can annotate differences or copy differences from one 
document to another. After documents have been edited to users 
liking, they can be saved individually. 



   

 

 

Brief Background 

Able2Extract Professional is an all-in-one PDF converter for both 
individuals and businesses. It supports converting native and 
scanned PDFs to MS Office and other formats, creating encrypted 
and password-protected files, editing PDF content, annotating, 
signing PDFs, reducing document size, and more, across Windows, 
macOS, and Linux platforms. 
 
 

 

System Requirements 

Operating system: 

● Windows 11/10, Windows Server 
2025/2022/2019/2016, 64-bit edition 

● macOS 15 (Sonoma), 13 (Ventura), 12 (Monterey), 11 
(Big Sur) 

● Ubuntu 24.10/24.04/22.04/20.04 

● Fedora 41/40/39/38/37/36/35 64-bit edition       

Processor: The processor has to be x86 architecture. Both 32-bit 
and 64-bit are supported. 

Hard Drive Space: 400 MB (Windows), 400 MB (Mac), 400 MB 
(Ubuntu), 400 MB (Fedora). 

Memory: 1+ GB of free memory available. 

Monitor: Windows and Linux - 1366 (Width) x 768 (Height) screen 
resolution (higher resolution screen required if OS scaling is more 
than 100%). Mac - 1366 (Width) x 768 (Height) or 1280 (Width) x 
800 (Height) non-Retina screen resolution, 2560 (Width) x 1600 
(Height) Retina screen resolution. 

Telephone and Email Support 

We provide top-tier customer support. Call us at +1 604 200 4366 
(M-F 9am-5pm EST) or email investintech_support@apryse.com  

mailto:investintech_support@apryse.com

